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Legal Disclaimer

A Caution

This document contains sample configuration content. Unless expressly stated otherwise in your
agreements with SAP, this sample content is not part of SAP product documentation and you may not infer
any product documentation claims against SAP based on this information.
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1 Integration of SAP TM with SAP
NetWeaver BW

Use

You use this guide to configure the integration of SAP Transportation Management (SAP TM) and SAP
NetWeaver Business Warehouse (SAP NetWeaver BW).

i Note

Since the visualization of query results in the business applications in SAP TM uses SAP Netweaver Portal
applications, you should set up SAP Netweaver Portal and connect it to the SAP Netweaver BW and SAP
TM Systems.

Prerequisites

Prerequisites in SAP TM

® You have transferred the application component hierarchy in transaction RSA9.

® You have transferred and activated the DataSources in transaction RSA5.
You find the DataSources below the hierarchy node Transportation Management DataSources
(0SCM_TM DATASOURCES):

o o0scM 1M (Transactional DataSources)
o 0scM_TM-I0 (Text DataSources)

To select and activate a DataSource choose a DataSource or node. Choose Select Subtree and Activate
DataSources.

e |f you want DataSources to update reference InfoObjects used by SAP TM Content in SAP NetWeaver BW,
the following DataSources are of interest:

© 0APO LOCNO ATTR
© 0APO_LOCNO TEXT
© OBPARTNER ATTR
© OBPARTNER TEXT
© OPRODUCT TEXT

© OCOUNTRY TEXT

i Note

0APO_LOCNO_ ATTR contains a Continent field that is only available for SAP TM if you have activated
the service API Business Add-In for the enrichment and have maintained the Continent Customizing for
SAP NetWeaver BW.

Prerequisites in SAP BW

Integration of SAP TM with SAP NetWeaver BW
4 PUBLIC Integration of SAP TM with SAP NetWeaver BW



® You have connected the SAP TM source system to the SAP NetWeaver BW system and replicated the
DataSources in transaction RSa1. To do so, you have chosen | Modeling ¥ Source Systems ¥ Create BW

Source System 1. As a result, the source system is displayed in the system list. For this source system, you
have executed the Replicate Data Sources function.

® You have activated the business content for application component 0scM TM (SCM Transportation
Management). As a result, the system generates active version A from the delivered business content
version D. This affects all object types of the application component, such as DataSources or
MultiProviders.
You have activated the relevant process chains in transaction RSa1 by choosing |+ Bl Content » Object

Type i Process Chain 3. To perform the activation, you have selected, transferred, and installed the
process chains.

Prerequisites in SAP Netweaver Portal

e You have connected the SAP Netweaver BW system to the SAP NetWeaver Portal. A detailed description
can be found at http://help.sap.com/nw74#% |+ Application Help ¥ Function-Oriented View » SAP Business
Warehouse p Configuration » Automatically Configuring Bl Java ¥ Setting Up BW Systems in the System
Landscape in the Portal » Creating BW Systems in the Portal 3

® You have maintained the system alias sap_BW in the enterprise portal to point to your BW system.

i Note

The iViews that are used can be found in the enterprise portal under |+ Portal Content » Content Provided

by SAP » End User Content » Platform Add-Ons ¥ Business Intelligence ¥ iViews 4. These iViews are
delivered as part of the standard delivery of the enterprise portal.

Process

The data gets loaded from the SAP TM system to the SAP NetWeaver BW into the Persistent Staging Area
(PSA). The data model and the data flow are important for performing the transaction data uploads and
verifying the results. The figures below illustrate the data flow for the individual business objects (BOs):

® Transportation Request (TR)

® Transportation Order (TO)

e Forwarding Settlement Document (FWSD)
e Freight Settlement Document (FSD)

e Business Share (BSH)

® Trade Lane (TDL)

® Freight Agreement (FAG)

Here a few analysis scenarios that are possible:

i Note

For a complete list of all analysis scenarios, see the SAP Help Portal at http://help.sap.com# | SAP
NetWeaver » Bl Content » All Releases » SAP NetWeaver 7.4 Bl Content 747 SP 07 4.

Integration of SAP TM with SAP NetWeaver BW
Integration of SAP TM with SAP NetWeaver BW PUBLIC 5


http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fnw74
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com

Data Processing
in BW System

MultiProvider

0TMS_MP11
Transportation Request

InfoCube a0

0TMS_C11
Transportation Request

DataStoreObject
0TMS_DS1 o
TR Root F

0TMS_DS15
TR Consolidated Rootand Item

0TMS_DS12

TR Item
h

Data Sources gscM_TM_TRQ ||
in TM System Transactional Data of BO
Transportation Request Root

" loscm_Tm_TRG_ M
Transactional Data of BO
Transportation Request ltem

Data flow for business object Transportation Request (TR)

Data Processing |_
in BW System E
¥,
[ "4
_ _ - 0TMS_MP22
MultiProvider T Transportation Request Stages
I
InfoCub - 0TMS_C22
nrot-ube '4\ Transportation Request Stages
——— 0TMS_DS38
DataStoreObject TR Consolidated Stage
0TMS_DS3 0TMS_DS15
TR Stage 0TMS DS11 TR Consolidated Root and ltem
TR Root 0TMS_DS12
A R Item

Data Sources ]

in TM System (5o Tiv_TRQ_STG
Transactional Data of BO
Transportation Request Stage

OSCM_TM_TRG
Transactional Data of BO
Transportation Request Root

——
——

r'_ _'.'|
OSCM_TM_TRQ_ITH
Transactional Data of BO
Transportation Request ltem

]

Data flow for business object Transportation Request (TR) enhanced by stages

6 PUBLIC

Integration of SAP TM with SAP NetWeaver BW
Integration of SAP TM with SAP NetWeaver BW




Data Processing

Transactional Data of BO
Transportation Order ltem

in BW System Té
/
[ "4
- OTMS_MP12
MultiProvider — Transportation Order
i
ek OTMS_C12
InfoCube ":’ Transportation Order
|
0TMS_DS16
. TO Consolidated
DataStoreObject Rootand Item
0TMS_DS14 0TMS_DS13
TO ltem A 4 TORoot
Data Sources in I--—-J I--—-J
TM System 0SCM_TM_TOR_ITM 0SCM_TM_TOR

Transactional Data of BO
Transportation Order Root

Data flow for business object Transportation Order (TO)

Data Processing
in BW System

MultiProvider

- 0TMS_MP23
";” Transporation Order Stages

I
£ 0TMS_C23

Transactional Data of BO
Transportation Order Stage

Transactional Data of BO
Transportation Order ltem

LR : Transportation Order Stages
0TMS_DS37
DataStoreObject O Consolidated Stage
0TMS_DS16
0TMS_D336 N TO Consolidated Rootand Item
TO Stage 0TMS_DS14
70 Itern 0TMS_DS13
A TO Root
Data Sources in ] ] f—L-'-']
TM System 50 1y ToR STG 0SCM_TM_TOR ITM  0SCM_TM_TOR

Transactional Data of BO
Transportation Order Root

Data flow for Transportation Order enhanced by stages

Integration of SAP TM with SAP NetWeaver BW
Integration of SAP TM with SAP NetWeaver BW

PUBLIC




Data Processing
in BW System

-~ O0TMS_MP21

MultiProvider Trade Lane Analysis

0TMS_C21
InfoCube Trade Lane
DataStareObiect OTVS_DS32
ataStoreObjec ;
] TO Trade Lane Consolidated 0TS D529
OTMS_DS16 OTMS_DS37 TO Trade Lane
TG Consolidated T0O Consolidated Stages
Root and Item
OTMS_DS13 OTMS_DS36
OTMS_DS14 TO Root A TOStage
TO tem
N N 1 N
Data Sources ] ] ] ]
in TM System 0scw_TW_TOR_ITM 0SCM_TM_TOR 0SCM_TM_TOR_STG 0SCM_TM_TOR_TDL
Transactional DataofBO Transactional Data of BO Transactional Dataof BO Transactional Data of BO

Transportation Orderltern  Transportation OrderRoat  Transpartation Order Stage Transportation Order Trade Lan

Data flow for Transportation Order enhanced by Trade Lane (TDL)

Data Processing
in BW System

0TMS_MP18
Transportation Order Execution

MultiProvider

-l <zf

InfoCube 0TMS_C1 8. )
Transportation Order Execution
] 0TMS_DS34
DataStoreObject O Execution Consolidated
0TMS_DS16
0TMS_DS36 0TMS_DS33 TO Consolidated
TO Stage TO Execution 0TMS_DS14 Rootand Item
Information TO Item 0TMS_DS1
TO Root
B - - 1 7 - -
Data Sources in [“ "] [“ N [—l [“ N
TM System - "_" '_" "_"
OSCM_TM_TOR_STG OSCM_TM_TOR_EXE OSCM_TM_TOR_ITM OSCM_TM_TOR,
Transactional Data of BO Transactional Data of BO Transactional Data of BO Transactional Data of BO

Transportation Order Stage  Transporation Order Execution  Transporation Orderltern  Transportation Order Root

Data flow for Transportation Order enhanced by Execution (EXE)

Integration of SAP TM with SAP NetWeaver BW
8 PUBLIC Integration of SAP TM with SAP NetWeaver BW



Data Processing | ,
in BW System =8
L4
o & OTMS_MP16
MultiProvider ~  Revenue Analysis
A
|
B 0TMS_C16
InfoCub e
hroLube A Revenue
0TMs_DS28
DataStoreObject FWSD Consolidated Charge ltems
0TS _Ds27
0TMS_D815 0TMS_DS22 FWSD Consolidated
VR Cengelickicd FW3D Transpertation Rootand ltem
oot and tems A Charges
0TMS_DS11 0TS D812 0TMS_DS21 Gt D20
L Fitv3D Root
TR Root F, TR ltemn FWSD ltem
A -
i — i - . ~
Data Sourcesin [ ] ] —] ]
TM System oscu TMTRQ  osom_TWLTROITM 0SCM_TM_CFIR_PTC OSCM_TM_CFIR_ITM 0SCM_TM_CFIR
TransactionalData  Transactiona Dataof  Transactional Dataof BOFWSDfor Transactional Dataof  Transactional Data
of BO TR Root BO TRItem Planned Transp. Charges BO FWSD ltern Of BO FWSD Root
Data flow for business object Forwarding Settlement Document (FWSD)
Data Processing |
in BW System g
o 0TMS_MP13
MultiProvider .1 Cost Anawsis
'——_________.....--?(--.....__________‘
~ 0TMS_C14 . 0TMS_C15
InfoCube " Planned Costs 5 Actual Costs
. 0TS _De25 FSD Consolidated 0TS _Ds2e FSD
DataStorEObJECt Charge tems Conszolidated Invoice
erification OIE LS
0TMS_DS232 FSD Invoice
FSD Transpottation 0THIS_DS24 OTHS_DS14 0TMS_DS Verifigation
Charges FSD Cons. Transportation TO Cons. Root
Root and tems e and ltems
0TMS_DS18 0TMS_DS17 Ui LE 1
FSD ltem FSD Root Transportation Order Root
Data Sources — — —— — — ——
: ] 3 O ] — ]
in TM System
O5CM_TM_SFIR_PTC OSCM_TM_SFIR_ITM  0SCM_TM_SFIR OSCM_TM_TOR_ITM OSCM_TM_TOR  OSCIM_TM_SFIR_I
Trans. Dataof BO FSD Transactional Data of Transactional Transactional Dataof  TransactionalData  Transactional Data of
far Planned Transportation BO FSD ltemn Datacf BOFSD BO TOlermn of BO TO Root BO FSD ltern IV
Charges Root

Data flow for business object Freight Settlement Document (FSD)

Integration of SAP TM with SAP NetWeaver BW

Integration of SAP TM with SAP NetWeaver BW PUBLIC 9




Data Processing
in BW System

MultiProvider

0TMS_MP19
Business Share

i@ @

InfoCube 0TMS_C19
Business Share
_ 0TMS_DS30
DataStoreObject Business Share

L%
-

Data Sources in
TM System

OJ

0SCM_TM_BSH
Transactional Data of
BO Business Share

Data flow for business object Business Share (BSH)

Data Processing
in BW System

MultiProvider

0TMS_MP20
Transportation Allocation

&— €§ f <=:ET'_I

0TMS_C20
InfoCube L Transportation Allocation
1
DataStoreObject A 0TMS_DS31

Transportation Allocation

10

Data Sources in
TM System

o .

i
0SCM_TM_TAL
Transactional Data of BO
Transportation Allocation

Data flow for business object Transportation Allocation (TAL)

PUBLIC

Integration of SAP TM with SAP NetWeaver BW
Integration of SAP TM with SAP NetWeaver BW




Data Processing
in BW System Wré
\7
* 0TMS_MP25
MultiProvider S  Agrooment
A
l . 0TMS_C25
InfoCube aa Agreement
4
: 0TMS_DS44
LEzsiEre e Agreement- Consolidated Rootand ltems
0TMS_DS41 0TMS_DS42 i 0TMS_DS43
Agreement N A Agreementltems T Agreement—
References
Data Sources I:J [jJ [jJ
in TM System OSCM_TM_FAG OSCM_TM_FAG_ITh 0SCM_TM_FAG_REF
Transactional Data of BO  Transactional Data of BO Transactional Data of BO Freight
Freight Agreement oot Freight Agreement lterm Agreement References

Data flow for business object Freight Agreement (FAG)

Integration of SAP TM with SAP NetWeaver BW

Integration of SAP TM with SAP NetWeaver BW PUBLIC 11



2 DataSources for Master Data and Texts

The following DataSources are used for master data and texts to transfer data one-to-one from the SAP
Transportation Management system to the SAP NetWeaver Business Warehouse system into the Persistent
Staging Area and then into the corresponding objects:

® (0SCM TM AGREEPARTROLE (Agreement Party Role)

® (0SCM TM AIRCRACO (IATA Aircraft Type Code)

® (0SCM TM AIRLINECD (Airline Code)

® (SCM TM AITYPT (Item Type)

® (0SCM TM BILLS (Settlement Basis)

® (0SCM TM BSHLINETYPE (Business Share Line Type)

® (SCM TM BTD ITEM TYPECODE (Document [tem Type for Business Transaction)

® (0SCM TM BTD TYPE CODE (Document Type for Business Transaction)

® 0SCM TM BTPRCD (Business Transaction Priority Code)

® (0SCM TM BUCKET TYPE (Bucket Type for Transportation Allocation)

® (0SCM TM CALCLEVEL (Calculation Level)

® 0scM TM CALRES (Calculation Resolution Base)

® (SCM TM CARGORCPT (Cargo Receipt Status on Item Level)

® (0scM TM CCODE (Commodity Code)

® (0SCM TM CCODE_TYPE (Commodity Code Type)

® (0SCM TM CFIRCAT (Forwarding Settlement Document Category)

® (SCM TM CFIRCLASS (Forwarding Settlement Document Classification)

® (0SCM TM CFIRCMRCD (Forwarding Settlement Document Credit Memo Reason)

® (0SCM TM CFIRLCS (Forwarding Settlement Document Life Cycle Status)

® (0SCM TM CFIRTYP (Forwarding Settlement Document Type)

® (SCM TM CHRTYPE (Charge Type)

® (SCM TM CONSOL (Buyer's or Shipper's Consolidation)

® (0SCM TM CONTINENT (Continent)

® (0SCM TM CONTRBAS (Contract Basis)

® (0scM TM CREATTYP (Creation Type of Transportation Order)

® (0SCM TM DGOERROR (Dangerous Goods Check Error)

e 0scM TM DIMWPT (Dimensional Weight Profile)

e 0scM TM DISTLVL (Distribution Level for Transportation Charge Distribution)

® 0scM TM DSTICAT (Distribution Category)

® (0sSCM TM DTTYPE (Downtime Type)

® (0SCM TM FAGDSC (Agreement Description Text)

® (0SCM TM FAGIDSC (Agreement Item Description Text)

® (0SCM TM FAG CAT (Agreement Category)

® (0SCM TM FAG PRIC (Agreement Priority)

® (SCM TM FAG RSTA (Agreement Status)

Integration of SAP TM with SAP NetWeaver BW
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0SCM TM FAG USAC (Freight Agreement Charge Usage)
0SCM TM FATYT (Agreement Type)

0SCM_TM HANDLCAR (Cargo Execution Status on Item Level)
0SCM_TM IATACODE (IATA Location Code)

0SCM TM INCCLCD (Incoterms Classification Code)

0SCM_TM INSTYPE (Instruction Type)

0SCM_TM ITMCAT (Item Category)

0SCM_TM LOCTYPE (Location Type)

0SCM_TM MOVETYPE (Movement Type)

0SCM_TM MULTISTOP (Multi-Stop)

0SCM_TM NATSECSTS (Country-Specific Air Cargo Security Status)
0SCM_TM ORGEXT (Organizational Unit External ID)

0SCM_TM ORIENTN BW (Trade Lane Orientation for BW)

0SCM_TM PACKTYPE (Package Type)

0SCM_TM PRD DGPROFL (DG Indicator Profile)
0SCM_TM PRD FRGHT GRP (Product Freight Group)
0SCM_TM PRD TRANSP GRP (Product Transportation Group Code)
0SCM TM REF LVL (Freight Agreement Reference Level)
0SCM TM REF TYP (Freight Agreement Reference Type)

0SCM_TM RESI (Resource)

0SCM_TM RFQRST (RFQ Status Reason)

0SCM_TM RFQTYT (RFQ Type)

0SCM TM RFQ IPER (RFQ [tem Periodicity)

0SCM_TM RFQ ITC (RFQ Item Type)

0SCM_TM RFQ RSC (Item Status)

0SCM_TM RFQ sc (RFQ Status)

0SCM_TM RSNCNCLCO (Reason for Cancellation)

0SCM_TM SCON (All Contractors)

0SCM_TM SCONP (All Contracting Parties)

0SCM_TM SECSTAT (General Security Status)

0SCM TM SET BY SERVICE (Origin of Entry)

0SCM TM SFIRCAT (Freight Settlement Document Category)
0SCM_TM SFIRCRT (Freight Settlement Document Creation Type)
0SCM_TM SFIRCST (Freight Settlement Document Item Confirmation Status)
0SCM_TM SFIRIVT (Freight Settlement Document Invoice Document Type)
0SCM TM SFIRLCS (Freight Settlement Document Life Cycle Status)
0SCM_TM SFIRTST (Freight Settlement Document Item Transfer Status)
0SCM_TM SFIRTYP (Freight Settlement Document Type)

0SCM_TM SHIPTYPE (Shipping Type)

0SCM_TM STAGETYPE (Stage Type)

0SCM_TM STA CAT (Stage Category)

0SCM TM STOP_ ASSGN_ CAT (Stop Assignment Category)
0SCM_TM STOP_CAT (Stop Category)

Integration of SAP TM with SAP NetWeaver BW
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0SCM_TM STOP ORIGIN (Stop Origin)

0SCM TM STOP_ROLE (Stop Role)

0SCM_TM S HDL EXEC STATUS (Handling Execution Status on Stop Level)
0SCM_TM TALCAT (Transportation Allocation Category)
0scM TM TALDSC (Transportation Allocation Description Text)
0SCM_TM TALLINETYPE (Transportation Allocation Line Type)
0scM TM TALTYP (Transportation Allocation Type Text)
0SCM_TM TAL LOAD_TYPE (Allocation Load Type)

0SCM_TM TCCATC (Charge Item Category Code)

0SCM_TM TccLsc (Charge Item Subcategory Code)

0SCM_TM TCDCHRCAT (Charge Category)

0SCM_TM TCDCHRSCAT (Charge Subcategory)

0SCM_TM TCDDISRULE (Distribution Rule)

0scM_TM TCDLNTP (Transportation Charge Distribution Line Type)
0SCM_TM TCETC (Charge Item Type Code)

0scM TM TIME DT (Time Determination Type)

0SCM_TM TMODECA (Transportation Mode Category)

0scM_TM TMODECD (Transportation Mode Code)

0SCM_TM TORCAT (Transportation Order Category)

0SCM_TM TORCOAL (Transportation Order Consolidation Allowed)
0SCM_TM TORCONSOLTY (Consolidation Type)

0SCM_TM TORCUSTACTINB (Customs Activity Inbound)

0SCM_TM TORDISCR (Discrepancy)

0SCM_TM TORDISCRBL (Discrepancy Type Leads to Block or Not)
0SCM_TM TORDISCRTY (Discrepancy Type)

0SCM_TM TOREVENTSTATUS (Transportation Order Event Status)
0SCM TM TOREXECINFO (Source of Execution Information)

0SCM TM TOREXEROLECAT (Execution Role Category)
0SCM_ TM TOREXETRANSACT (Transportation Activity)

0sCcM_TM TORLCS (Transportation Order Life Cycle Status)
0SCM_TM TORTDLRELTYPE (Relation Type of Trade Lane for BW)
0SCcM_TM TORTYP (Transportation Order Type)

0sSCcM_TM TRAFFICD (Traffic Direction)

0SCM_TM TRAZONE (Transportation Zone)

0SCM_TM TRAZONE HIER (Transportation Zone Hierarchy)
0SCM TM TRMEANS (Means of Transport)

0SCM_TM TRQCAT (Transportation Request Category)

0SCM_TM TRQITEMT (Type of Transportation Request Item)
0SCM_TM TRQLCS (Transportation Request Life Cycle Status)
0SCM_TM TRQSHIPSECSTAT (Shipper Security Status)

0scM_TM TRQTYP (Transportation Request Type)

0SCM_TM TRSLCD (Transportation Service Level)

0SCM_TM TRSLCD CARRIER (Transportation Service Level Code — Carrier)
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® (SCM TM TRSLCD SALES (Transportation Service Level Code — Sales)
® 0scM TM TSRT (Service Type)

® (0SCM TM TURESCAT (Equipment Group)

® (SCM _TM TURESTCO (Equipment Type)

® (0SCM TM ULDCLASS (Unit Load Device Rate Class)

® (0SCM TM ULDTYPE (Unit Load Device Rate Type)

® (0ScM TM VEHDESC (Vehicle Resource Description)

® (0SCM TM VEHTYPE (Resource Class)

i Note

DataSource 0SCM TM TRAZONE HIER is especially used to upload the zone hierarchy, which is based for
locations and therefore updates the hierarchy of InfoObject 0APO_LOCNO.
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3 DataSources for Transactional Data

The following DataSources are used for transactional data to transfer data one-to-one from the SAP TM system
to the SAP NetWeaver BW system into the Persistent Staging Area (PSA) and then into the DataStore object
(DSO):

16

0SCM TM BSH

Transactional Data of Business Object Business Share

0SCM_TM TAL

Transactional Data of Business Object Transportation Allocation

0SCM_TM TRQ

Transactional Data of Business Object Transportation Request

0SCM_TM TRQ ITM

Transactional Iltem Data of Business Object Transportation Request

0SCM_TM TRQ STG

Transactional Data of Stage Information of Business Object Transportation Request
0SCM_TM TOR

Transactional Data of Business Object Transportation Order

0SCM_TM TOR_ITM

Transactional Iltem Data of Business Object Transportation Order

0SCM_TM TOR EXE

Transactional Data of Execution Information of Business Object Transportation Order
0SCM_TM TOR_STG

Transactional Data of Stage Information of Business Object Transportation Order
0SCM_TM TOR TCD

Transactional Data of Charge Distribution of Business Object Transportation Order
0SCM_TM TOR_ TDL

Transactional Data of Trade Lanes of Business Object Transportation Order

0SCM_TM CFIR

Transactional Data of Business Object Forwarding Settlement Document

0SCM _TM CFIR ITM

Transactional Item Data of Business Object Forwarding Settlement Document

0SCM_TM CFIR_PTC

Transactional Data of Business Object Forwarding Settlement Document for Planned Transport. Charges
0SCM_TM SFIR

Transactional Data of Business Object Freight Settlement Document

0SCM TM SFIR ITM

Transactional Item Data of Business Objects Freight Settlement Document

0SCM_TM SFIR _PTC

Transactional Data of Business Object Freight Settlement Document for Planned Transportation Charges
0SCM_TM SFIR IV

Transactional Data of Business Object Freight Settlement Document Item IV Information (Actual Costs)
0SCM TM SFIR TCD

Transactional Data of Charge Distribution of Business Object Freight Settlement Document

Integration of SAP TM with SAP NetWeaver BW
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® (SCM TM FAG
Transactional Data of Business Object Freight Agreement
® (0SCM TM FAG ITM
Transactional Data of Business Object Freight Agreement Item
® (0SCM TM FAG REF
Transactional Data of Business Object Freight Agreement References

Integration of SAP TM with SAP NetWeaver BW
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4 Defining the BW Relevance for Business

Document Types

Context

You use this procedure to indicate business document types of business documents (for example, a forwarding
order) relevant for SAP NetWeaver BW. During an upload from SAP TM to SAP NetWeaver BW, data is
transferred from the documents indicated as relevant.

You can indicate the following business document types as relevant for SAP NetWeaver BW:

Freight order types

Freight booking types

Freight unit types

Forwarding order types

Forwarding quotation types

Forwarding settlement document types

Freight settlement document types

Order-based transportation requirement types
Delivery-based transportation requirement types
Transportation allocations and business shares
Freight agreement RFQ types

Forwarding agreement quotation types

Freight agreement types

Forwarding agreement and service product catalog types
Internal agreement types

Procedure

In Customizing for SAP TM, choose one of the following paths:

o

18

BW relevance of freight order types:
SAP Transportation Management » Transportation Management

Order » Define Freight Order Types
Select the BW Relev. checkbox.

BW relevance of freight booking types:
SAP Transportation Management » Transportation Management

Booking # Define Freight Booking Types
Select the BW Relev. checkbox.

Freight Order Management » Freight

Freight Order Management » Freight

Integration of SAP TM with SAP NetWeaver BW
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BW relevance of freight unit types:
| SAP Transportation Management j Transportation Management » Planning ¥ Freight Unit » Define

Freight Unit Types 3.
Select the BW Relev. checkbox.

o  BW relevance of forwarding order types:
| SAP Transportation Management ¥ Transportation Management » Forwarding Order Management

Forwarding Order ¥ Define Forwarding Order Types 3.
Select the BW Relev. checkbox.

o BW relevance of forwarding quotation types:
| SAP Transportation Management ¥ Transportation Management » Forwarding Order Management

Forwarding Quotation j Define Forwarding Quotation Types .
Select the BW Relev. checkbox.

o BW relevance of forwarding settlement documents:
| SAP Transportation Management » Transportation Management » Settlement » Forwarding Settlement

» Define Forwarding Settlement Document Types 4.
Select a Forwarding Settlement Document. Choose Details. Select the BW Relev. checkbox.

o BW relevance of freight settlement documents:
| SAP Transportation Management » Transportation Management » Settlement » Freight Settlement »

Define Freight Settlement Document Types 4.
Select a Freight Settlement Document. Choose Details. Select the BW Relev. checkbox.

o  BW relevance of order-based transportation requirements:
| SAP Transportation Management  Integration » ERP Logistics Integration » Order-Based Transportation

Requirement ¥ Define Order-Based Transportation Requirement Types 4.
Select the BW Relev. checkbox.

o BW relevance of delivery-based transportation requirement types:
| SAP Transportation Management } Integration » ERP Logistics Integration ¥ Delivery-Based

Transportation Requirement j Define Delivery-Based Transportation Requirement Types 3.
Select the BW Relev. checkbox.

o BW relevance of transportation allocations and business shares:
| SAP Transportation Management  Planning # General Settings # Define Transportation Allocation
Settings 3.
Select the TAL BW Relevance checkbox (Transportation Allocation).
Select the BS BW Relevance checkbox (Business Share).

o BW relevance of freight agreement RFQ types:
| SAP Transportation Management ¥ Transportation Management » Master Data » Agreement RFQs and

Quotations » Define Freight Agreement RFQ Types 4.
Select the BW Relev. checkbox.

o  BW relevance of forwarding agreement quotation types:
| SAP Transportation Management » Transportation Management » Master Data » Agreement RFQs and

Quotations j Define Forwarding Agreement Quotation Types 3.
Select the BW Relevance checkbox.

o  BW relevance of freight agreement types:
| SAP Transportation Management » Transportation Management » Master Data » Agreement and

Service Products ¥ Define Freight Agreement Types 3.

Integration of SAP TM with SAP NetWeaver BW
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Select the BW Relevance checkbox.
o  BW relevance of forwarding agreement and service product catalog types:
| SAP Transportation Management » Transportation Management » Master Data » Agreement and
Service Products » Define FWA and Service Product Catalog Types .
Select the BW Relevance checkbox.
o  BW relevance of internal agreement types:
| SAP Transportation Management » Transportation Management » Master Data » Agreement and

Service Products  Define Internal Agreement Types 3.
Select the BW Relevance checkbox.

Integration of SAP TM with SAP NetWeaver BW
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5 Setting Up the Initial Data Upload to SAP
NetWeaver BW

Use

You use this procedure to perform an initial data upload from SAP TM to SAP NetWeaver BW and to initialize
the delta queues. The initial data upload is done using setup tables in SAP TM for existing data.

The following initialization options are available:

e Deltainitialization without data transfer
In this case, the system does not use setup tables and initialization reports in SAP TM. There is only an
initialization from SAP NetWeaver BW.
® Deltainitialization with data transfer
In this case, you must do the following:
o Delete all data in the setup tables.
o Fill the setup tables with data from the extractor.
o Check datain the setup tables.
For more information, see the Procedure section further down in this topic.

- Recommendation

To avoid data loss, run the initial upload when there is no data traffic.

i Note

The delta initialization with data transfer is one option to do the initial data upload and delta initialization in
one step. Furthermore, it is also possible to do this in two steps:

1. Initial data upload with update mode Full Update
2. Deltainitialization without data transfer

Prerequisites

To display the SAP TM-specific menu on the SAP Easy Access screen, choose the Customizing activity
Definition on initial menu in Customizing for SAP NetWeaver under |» Application Server # System
Administration 2, and set the initial menu to /SCMB/MENUE.
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The system considers only business objects for the initial data upload which have the following life cycle status

values:

Business Object

Life Cycle Statuses

Transportation request

Completed

Transportation order

In Customizing, you can add the status values In Process,
New, and Completed.

Forwarding settlement document

Ready for Invoicing in SAP ERP

Transferred for Invoicing in SAP ERP

Invoiced in SAP ERP

Ready for Credit Memo Creation in SAP ERP
Transferred for Credit Memo Creation in SAP ERP

Credit Memo Created in SAP ERP

Freight settlement document

Ready for Accruals
Transferred for Accruals
Accruals Posted

Invoice Verified in SAP ERP

Transportation allocation

Not applicable

Business share

Not applicable

Trade lane

Not applicable

Transportation order execution information

Not applicable

Master RFQ Published
RFQ Submitted
Service product and agreement Released

Procedure

Step 1: Initializing the Setup Tables

1. Todelete all data in the setup tables, on the SAP Easy Access screen, choose | Transportation
Management » Administration ¥ Initial Data Upload to SAP NetWeaver BW ¥ Initialize Setup Tables 3.
2. Select setup tables by selecting the corresponding checkboxes (for example the Transportation Order

checkbox).
3. Choose Execute.
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Result: The setup tables are empty.

Step 2: Filling the Setup Tables (Initialization with Data)

1. Toload existing data into the setup tables, on the SAP Easy Access screen, choose one of the following
paths:

o

| Transportation Management » Administration ¥ Initial Data Upload to SAP NetWeaver BW » Upload

of Transportation Requests 4

The Transportation Request Selection for Init. Upload to SAP NetWeaver BW screen appears.

Under Business Document Identification and under Management Data, you can enter selection criteria,
if required.

|» Transportation Management » Administration ¥ Initial Data Upload to SAP NetWeaver BW » Upload

of Transportation Orders J

The Transportation Order Selection for Initial Upload to SAP NetWeaver BW screen appears.

Under Business Document Identification and under Management Data, you can enter selection criteria,
if required.

Under Additional Extraction, you can specify whether you want to upload Trade Lanes, Transportation
Order Execution Information, and/or Charge Distribution data. Choose the appropriate checkbox.

| Transportation Management » Administration ¥ Initial Data Upload to SAP NetWeaver BW » Upload

of Forwarding Settlement Documents 3

The FWSD Selection for Initial Upload to SAP NetWeaver BW screen appears.

Under Business Document Identification and under Management Data, you can enter selection criteria,
if required.

|» Transportation Management » Administration ¥ Initial Data Upload to SAP NetWeaver BW » Upload

of Freight Settlement Documents J

The FSD Selection for Initial Upload to SAP NetWeaver BW screen appears.

Under Business Document Identification and under Management Data, you can enter selection criteria,
if required.

Under Additional Extraction, you can specify whether you want to upload Charge Distribution data.
Choose the appropriate checkbox.

|» Transportation Management » Administration j Initial Data Upload to SAP NetWeaver BW » Upload

of Business Shares 3

The Business Share Selection for Initial Upload to SAP NetWeaver BW screen appears.

Under Business Document Identification and under Management Data, you can enter selection criteria,
if required.

|» Transportation Management » Administration » Initial Data Upload to SAP NetWeaver BW » Upload

of Transportation Allocations J

The Transportation Allocation Selection Initial Upload to SAP NetWeaver BW screen appears.

Under Business Document Identification and under Management Data, you can enter selection criteria,
if required.

|» Transportation Management » Administration ¥ Initial Data Upload to SAP NetWeaver BW » Upload

of Agreements J
The Agreement Selection Initial Upload to SAP NetWeaver B screen appears.
Under Business Document Identification, you can enter selection criteria, if required.

2. Choose Execute.

Result: When loading data into the SAP NetWeaver BW system, the corresponding setup tables are filled with
data from the extractor.
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i Note

Instead of using the setup programs via SAP Easy Access, there is another way to get the setup tables
filled. This procedure is especially developed for SAP TM and provides a complete guided procedure in
order to initialize setup tables, do a complete setup of all required DataSources, and check the result of the
setup. This procedure can be found at [» SAP NetWeaver Business Client » Application Administration » Bl

Processing ¥ Bl Extractor Cockpit for Setup of Statistic Data 3.

This guided procedure is especially made for huge amounts of data for the complete setup of SAP TM
statistic data on the customer site and provides six steps. Therefore it doesn't provide the setup of single
documents, for example, for text reasons.

Initialize setup tables.
Maintain package sizes.

Start extraction.

Monitor extraction.

RFC log of extraction process.

oo s wN e

View setup tables (this is a higher performing method than using transaction RSA3 or the Extractor
checker).

Step 3: Checking the Data in the Setup Tables
1. Access the Maintain DataSources report (transaction RSa6) to perform a DataSource extraction test.

2. On the Postprocess DataSources and Hierarchy screen, choose [ Transportation Management DataSources
» Transportation Management 4.

3. Select a DataSource.

4. Inthe context menu of the DataSource, choose DataSource Extraction Test.

Result: The system displays the data records in a detailed view.
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6 Enabling a Delta Data Upload to SAP
NetWeaver BW in SAP TM

Use

You use this procedure to make the settings for a delta data upload from one of the following business objects

in SAP TM to SAP NetWeaver BW:

e Transportation order (TO)

® Transportation request (TR)

® Freight settlement document (FSD)

e Forwarding settlement document (FWSD)
® Business share

® Transportation allocation

® Freight agreement

Prerequisites

You have performed an initial data upload to SAP NetWeaver BW (initialization with or without data transfer).
For more information, see section Setting Up the Initial Data Upload to SAP NetWeaver BW [page 21].

Procedure

Step 1: Enabling Delta Data Upload for Business Objects

1. In Customizing for SAP TM, choose |» Cross-Application Components » Processes and Tools for Enterprise

Applications » Reusable Objects and Functions for BOPF Environment » PPF Adapter for Output
Management -> Maintain Output Management Adapter Settings
2. Choose the dialog structure Direct Output Agents (w/0 PPF & w/0 History).
3. Select one of the following agents:
o Transportation Order: TOR_BW_EXTRACTION
o Transportation Request: TRO BW EXTRACTION
o Freight Settlement Document: SFIR BW EXTRACTION
o Forwarding Settlement Document: CFIR BW EXTRACTION
o Business Share: BSH_BW_EXTRACTION
o Transportation Allocation: TAL _BW_EXTRACTION
o Freight Agreement: FAG BW EXTRACTION
4. Choose Details.
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5. Select the Enable checkbox.
Step 2: Checking the Delta Queue

Access the BW Delta Queue Monitor report (transaction RSA7).
Select a DataSource.

Choose Display data entries.

Select the update mode Delta Update to check the RFC queue.

AW

Result

Once the delta data upload is enabled, the system calls the processor class when you save a business
document. The system checks whether the upload conditions are fulfilled (for example, if the life cycle status is
set to Completed). If the conditions are fulfilled, the system writes the data from the business object to the
delta queues.
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7 Enrichment of Location Master Data with
the Continent Field

In Customizing for SAP Transportation Management (SAP TM), choose || Transportation Management
Integration ¥ Integration to SAP NetWeaver Business Warehouse » Assign Country to Continent
In this Customizing activity, you assign a country to its continent. You can define a code for each continent and

then you can enter a country name and code for which you can specify a continent. This setting is relevant to Bl
extraction for location master data only.

You must specify a default continent for each country - a default continent is required for the system to
successfully complete Bl extraction for location master data with DataSource 0APO_LOCNO_ATTR. The system
uses this data to identify a continent for a given location.

You must only specify one default continent for each country.
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8 Specifying Metachains and Process
Chains for SAP TM Bl Content

Use

Metachains and process chains provide parts of business object (BO)-specific data flows. You can use process
chains like modules to set up a customer-specific data flow.

Features

® You can use the standard process or metachains delivered by SAP.

i Note

You need to manually activate these process or metachains. You can select process chains using the
textual description (such as Transport*) or the technical name (such as 0ScM*).

SAP delivers process and metachains in the following components:

o Extraction Layer

o Data Mart Layer
o Metachains

i Note

You use the delivered metachains only for the delta data upload to SAP NetWeaver BW.

® You can create customer-specific process chains and combine process chains to a new grouping. The
result of this grouping constitutes a new metachain.

Overview of Metachains and Process Chains

Below find an overview of the metachains, the process chains a metachain contains, and the order of execution
of the process chains. In a metachain, first the process chains of the extraction layer and then the process
chains of the data mart layer are executed. A metachain leads to an InfoCube.

InfoCube Metachain Process Chain Extraction Layer Process Chain Data Mart Layer
Actual Actual 1. TO Consolidated 1. Actual Costs
(0SCM_TM TOR_CONS) (0SCM_TM ACTUAL COSTS

Costs (0TMS_C15)

Costs (0SCM_TM META AC
T_COSTS)

2. FSD Consolidated )
(0SCM_TM_FSD_CONS)

3. FSD Invoice Verification
(0SCM_TM FSD IV INFO)
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InfoCube Metachain Process Chain Extraction Layer Process Chain Data Mart Layer
Planned Costs Planned 1. TO Consolidated 1. Planned Costs
(0TMS_C14) Costs (0SCM_TM META PL (0SCM_TM TOR_CONS) (0SCM_TM_PLANNED COST
~COSTS) 2. FSD Consolidated S)
(0SCM_TM FSD CONS)
3. TO Stages
(0SCM_TM TOR_STG)
4. FSD Planned Transporta-
tion Charges
(0SCM_TM FSD PCHARGES
)
Business Business Share Analysis 1. Business Share 1. Business Share
Share (0TMS_C19) (0SCM_TM META BSH) (0SCM_TM_BSH) (0SCM_TM BSH CUBE)
Transportation Order Ex- Execu- 1. TO Consolidated 1. Execution
ecution (0TMS C18) tion (0SCM_TM META EXE) (0SCM_TM_TOR_CONS) (0SCM_TM_TOR_EXE_CUBE
2. TO Execution )
(0SCM_TM TOR EXE)
3. TO Stages
(0SCM_TM TOR_STG)
Revenues (0TMS C16)  Revenues 1. TR Consolidated 1. Revenues
(0SCM_TM META REVENUE (0SCM_TM TOQ CONS) (0SCM_TM REVENUES)
S) 2. FWSD Consolidated
(0SCM_TM_FWSD_CONS)
3. FWSD Planned Tranporta-
tion Charges
(0SCM_TM FWSD_PCHARGE
S)
Transportation Alloca- Transportation Allocation 1. Transportation Allocation 1. Transportation Allocation
tion (0TMS C20) (0SCM_TM META TAL) (0SCM_TM_TAL) (0SCM_TM TAL CUBE)
Trade Lanes Trade Lane 1. TO Consolidated 1. TO Stages Consolidated
(0TMS_C21) (0SCM_TM META TDL) (0SCM_TM TOR_CONS) (0SCM_TM_TOR_STG_CONS
2. TOTrade Lanes )
(0SCM_TM TOR_TDL) 2. Trade Lanes
3. TO Stages (0SCM_TM TOR TDL CUBE
(0SCM_TM TOR_STG) )
Transportation Order Transportation Oder 1. TO Consolidated 1. Transportation Order Data
(0TMS C12) (0SCM_TM META TOR) (0SCM_TM TOR CONS) (0SCM_TM TOR CUBE)
Transportation Request ~ Transportation Request 1. TR Consolidated 1. Transportation Request

(0OTMS_C11)

(0SCM_TM META TRQ)

(0SCM_TM_TRQ CONS)

Data
(0SCM_TM_TRQ CUBE)
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InfoCube Metachain Process Chain Extraction Layer Process Chain Data Mart Layer

Transportation Order TO 1. TO Consolidated 1. TO Stages Consolidated
Stages (0TMS _C23) Stages (0SCM_TM META T (0SCM_TM_TOR_CONS) (0SCM_TM TOR STG CONS
OR_STG) 2. TO Stages )

(0SCM_TM TOR STG) 2. TO Stages

(0SCM_TM_TOR_STG_CUBE
)

Transportation Request TR 1. TR Consolidated 1. TR Stages
Stages (0TMS _C22) Stages (0SCM_TM META T (0SCM_TM_TRQ_CONS) (0SCM_TM TRQ STG CUBE
RQ STG) 2. TR Stages )

(0SCM_TM TRQ STG)

Agreement (0TMS_C25) Agreement 1. Agreement 1. Agreement
(0SCM_TM META FAG) (0SCM_TM FAG) (0ScM_TM FAG CUBE)
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9 Business Add-Ins

Use

You can use the following Business Add-Ins (BAdIs) to specify conditions or to enhance the extraction
structures for the data upload:

e BAdI: Condition for Extraction
You use this BAdI to change the conditions for the initial or delta upload of business objects data. For
example, you specify that the business document data to be uploaded has a life cycle status other than
Completed.

e BAdI: Fill Extraction Structures
You use this BAdI to enhance the extraction structures for the data upload of the different business objects.
For example, you specify that the system fills fields differently in the standard extraction structure or uses
additional fields in a customer append.

Activities

To access the BAdls, choose in Customizing for SAP TM one of the following paths:

o | SAP Transportation Management » Transportation Management » Business Add-Ins (BAdls) for
Transportation Management ¥ Basic Functions » Business Warehouse » BAdI: Condition for Extraction J

o |p SAP Transportation Management ¥ Transportation Management ¥ Business Add-Ins (BAdls) for
Transportation Management » Basic Functions j» Business Warehouse ¥ BAdI: Fill Extraction Structures 3
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

o Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
e The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
e SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.
e Links with the icon &: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such
links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.
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or for any purpose without the express permission of SAP SE or an SAP
affiliate company. The information contained herein may be changed
without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software vendors.
National product specifications may vary.
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informational purposes only, without representation or warranty of any
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